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Introduction

This page will instruct you to install and configure Eclipse as your MidiBox Integrated Development
Environment (IDE). Eclipse is supported on multiple platforms, including Windows, Linux and Mac OS.
The long-term goal is for this wiki page to provide instruction for all platforms. As it stands today,
these instructions are written for use on the following operating systems:

¢ Windows XP Professional SP3
¢ Windows 7 Ultimate SP1
e Ubuntu Linux 10.10

The following software versions were used when generating these instructions. As these free and
open-source tools evolve, the user interfaces may change and appear different from those displayed
here.

e Java Runtime Environment: Sun Java 5 Update 22

e Eclipse: Helios Service Release 2, build ID 20110218-0911
e MSYS: 1.0.11

e CodeSourcery G++: Lite 2010.09-51

e OpenOCD:

Install Eclipse

Eclipse is a Java application, and therefore requires you to have a Java Runtime Environment (JRE)
installed on your computer. The recommended JREs for use with Eclipse, handily sorted by computer
operating system, can be found on this web page. Download the JRE and install according to the JRE
provider's instructions.

Download Eclipse from this web page. Eclipse comes in a few flavors. For use as a MidiBox IDE, you
want to download “Eclipse IDE for C/C++ Developers”. This Eclipse package includes the C/C++
Development Tooling (CDT), which makes Eclipse C and C++ friendly. Be sure to select the correct
version for your computer's operating system (32- or 64-bit).

Installation is very easy: simply extract the archive you downloaded from the Eclipse website and
copy the contents to your computer's hard drive. Because there is no formal installation, you will need
to generate your own desktop shortcuts, if desired.

Optional Eclipse Workspace Configurations

Open Eclipse. You may be prompted to select a workspace. If unfamiliar with Eclipse, you should just
use the default workspace location for now.

MIDIbox - https://www.midibox.org/dokuwiki/


http://www.eclipse.org/downloads/moreinfo/jre.php
http://www.eclipse.org/downloads/
http://www.eclipse.org/cdt/
http://www.eclipse.org/cdt/

Last update: 2012/07/16 23:54 eclipse https://www.midibox.org/dokuwiki/doku.php?id=eclipse&rev=1342482891

& Workspace Launcher f'5_<|

Select a workspace

Eclipse stores wour projects in a folder called a waorkspace.,
Choose a workspace folder to use For this session,

Workspace: | C:\Documents and SettingstAdministr sboriworkspace v| [ Browse. ..

[[] Use this as the default and do not ask again

[ OF H Cancel ]

If you are presented with the 'Welcome' screen, click the “Go To the Workbench” link.

Workbench
S0 to the workbench

You should now be presented with the Eclipse workbench. To configure your workspace, select
'Preferences' from the 'Window' menu.

& C/C++ - Eclipse

File Edit Source FRefackor Mawvigate Search  Project Fun BEGEEES Help

Mew Windaw

-

Open Perspective
Shiowa Wiew r

Customize Perspective. ..
Save Perspective As, .,
Resek Perspective...
Close Perspective

Close all Perspectives

MNavigation +

Preferences

You are now presented with the 'Preferences' window where you will configure your workspace.

By default, Eclipse will build a project every time you open the project or switch to it. This “feature”
can sometimes be extremely annoying. To disable this behavior, select General-Workspace in the
'Preferences' window and uncheck the 'Build automatically' option.
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& Preferences

| | Workspace

[=)- General
Appearance

Compare/Patch
Content Types [ ] Build automatically

See 'Startup and Shukdown' For warkspace startup

Editors [ |Refresh autamatically
L] . [ ]5ave automatically befare build
Metwork Connections
Perspectives [ ] always close unrelated projects without prompk
Search
: E—
SECUrity Workspace save interval (in minukes): | S
Starkup and Shutdown —
Weh Browser Waorkspace name (shown in window tite):

\Warks pace

Build Order
Linked Resources
Local Hiskary

Cpen referenced projecks when a project is open:
ilways () Mever (%) Prompt

You can define Environment variables that will only be used by Eclipse. You can use this feature
instead of modifying the operating system environment variables. To define Environment variables,
select C/C++-Build»Environment in the 'Preferences’ window and click the 'Add' button on the right.
These environment variables will automatically apply to all projects in the workspace, and you can
override them on a per-project basis by modifying the projects' configurations.

| | | Environment Ll >
General
G+ Environment variables to set [ ]|
Appearance o o ‘m'
; ariable alue
[=I- Build -
Euild Yariables MIOS32Z_BIN_PATH ${MICS3Z_PATHHBIN Select. ..
C | MIOS3Z_BOARD MEHP_CORE_STM32
ro MIOS3Z_FAMILY STM3ZFL 03
Environment MIDS3Z_GCC_PREFIX arm-none-eabi
Make Targets MIDS3Z_LCD cled
Makefile Editor MIDS3Z_PATH I tsubversionfmios32
Code Style MIOS32_PROCESSOR STM32FL03RE

Debug
Editar
File Types
Indexer
Language Mappings Value: | | [ Variables ]
Mew COT Project Wizard
Property Pages Settings

Task Tags
Template Default Walues

Help

& New variable

Name: | |

You can also modify the PATH environment variable that will be used within Eclipse. This is
particularly useful if you want to switch between different toolchains, or use a particular toolchain for
one of your projects.

For Windows, add a variable 'Path' and give it a value something like the following:
C:\msys\1.0\bin;C:\Program Files\CodeSourcery\Sourcery G++ Lite\bin;${Path}
For Linux, add a variable 'PATH'

${HOME}/mios32 toolchain/bin:${env_var:PATH}

Note the value you enter for the PATH variable may be different than the above depending upon
where you installed the MidiBox toolchain.
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Setup Eclipse as MIOS32 IDE

It is assumed that you have completed the MIOS32 toolchain installation for your particular system
(either Windows or Linux) and have successfully obtained the MIOS32 source code prior to completing
the instructions that follow.

Configure Your Workspace

The Eclipse project files in the MIOS32 repository are created to make use of a relative path to the
MIOS32 directories. This is required because the MIOS32 code can be located anywhere within a
developer's file system. We will create the path variable in our workspace which is referenced by the
project file, allowing Eclipse to locate all the directories specified by the project file. In the
'Preferences' window, select General-Workspace—-Linked Resources from the tree in the left-hand
pane. Click the 'New..." button on the right. Give the variable the name 'MIOS32_ROOQOT', then specify
the location of your MIOS32 checkout on your computer (this may be something like
'C:\subversion\mios32\trunk', or for Linux '~/mios32'). You can also select the directory by browsing to
it after clicking the 'Folder..." button.

i v
Weh Browser Defined path variables:
= Woarkspace Marme Yalue ‘ MeEw, ., '
Build Crder
Linked Resources
Local Hiskory
- CIC+H+
- Help : —
- InstalfUpdats £ New Variable |L|@@
[+~ RunDebug
¥ Tasks Define a New Path Variable
[ Team Enter a new variable name and its associated location,
[+ Usage Data Colleckor
Name: | MIOS32_ROCT _
Locakion: .C:'I,SLItI\-'ErSiDI'I'I,miDSSZ . Eile... ] ¢ Folder... |
':?J [ (04 ] [ Zancel ]
=
'\‘?f,' [ 0] 4 l [ Cancel ]

Import the Template Projects

Select 'Import...' from the 'File' menu or right-click in the whitespace of the Project Explorer pane on
the left and select 'Import..."' from the menu that appears.
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& C/C++ - Eclipse
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L7 Export...
Properties Alk+Enker

Exit

& C/C++ - Eclipse

File Edit Source FRefackor Mavigate Search

(3~ - AR C
I-—Ii"lF'rDjEEt Explorer &3 - = H
EE|® T
Mew 3
L Export...
# | Refresh F5

You will be presented with the 'Import' window. Expand 'General' and select 'Existing Projects into
Workspace', click 'Next >' button.
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& Import
Select
E\J ]
Create new projects from an archive file ar direckary,

Select an import source:

== General
[E Archive File
Existing Projects into Workspace
[:L File Systemn
=L Preferences
= ofc++
= Cvs
[= PunDebug
= Tasks
[== Team

Click the 'Browse..." button next to 'Select root directory'. Browse to your MIOS32 directory and select
the folder \apps\templates\app_skeleton_cpp, click 'OK" button. The app_skeleton_cpp project should
appear in the 'Projects' field of the 'Import’ window, its checkbox should be checked. Click 'Finish'’
button.
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& Import |._,@
Import Projects =
Select a directory to search For existing Eclipse projects, E ;

-

(%) Select rook directory: | C\subversionimios324 appsikemplatestapp_sk | | Browse. .. |

() Select archive file: | |

Projects:

app_skeleton_cpp {C:\subversionymios 324 appsitemplates! app_ske Select Al

Deselect Al

ol

Refresh

£

| 2

|:| Copy projects inko workspace
Working sets
[ ]add project to working sets

@) Mext Finish ] [ Cancel
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Browse For Folder

Select root directory of the projects to import

= I subversion ~
= ) mins32
= I apps
i) benchmarks
# g controllers
) examples
# (5 mins32_test
i) miisc
# ) sequencers
57 syrthesizers
= 50 templates
E app_skeleton
: skeleton cpp
5 troubleshooting
[ (50 tutorials
k) bin
) boatloader
M & dnr V

Faolder: E app_skeleton_cpp |

[ Make Mew Falder ] [ K, ] [ Cancel ]

The app_skeleton_cpp project should now appear in the Project Explorer pane in Eclipse. If you've
done everything correctly, you should be able to browse the MIOS32 source code in the
app_skeleton_cpp project's linked directories. Repeat the above steps to import the app_skeleton
project into Eclipse.

Build a Project

If you have performed all steps correctly, you should be ready to build this project. Select the
app_skeleton_cpp project, right-click and select 'Build Project'. You can also select 'Build Project’ from
the 'Project' menu, or use the keyboard shortcut 'CTRL+B".
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{( Project Explorer &2 =
BER| &7
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The console output should be visible in the '‘Console' pane of Eclipse.

& C/C++ - Eclipse

File Edit Source Refactor Mavigate Search Project Run window  Help

=
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[“g FreeRTOS
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(o mios32
g modules

v@ Programming_fnodels
= project_build

[€ app.cpp

[8] app.h

@ mios32_config.h

| @& Makefile

= project.hex
README. txt

(R o S R R e R R

—
L
1

0
]

[&,Problems \Z—;,Tasks Bl conscle #32 = Properties @ ‘ﬁ |<}==(>| '_E ;r_;ﬁ G| ™
C-Build [app_skeleton_cpp] _
Creating object file for otgd f5 ped.o
Creating object file for app led.c
Creating ohject file for app.cpp
Creating object file for mini_cpp.cpp
Creating object file for freesrtos_heap.cpp
Application successfully built for:
Processor: STM3ZF103RE
Family: STM3IZF10x
Board: HEHF_CORE_STH3Z
LCD: cled
arm-none-eahi-size project._buildfproject.elf
text data hss dec hex filename
41923 t=1=] 12416 54432 ddal project_build/prnject.elf

e : a | QEY
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Some Useful Things to Observe

The app_skeleton_cpp build produced a warning, you can see this warning is highlighted in red in the
console pane. Eclipse is able to parse the console output of the build and highlight warnings and
errors for you. Even better still, you can double-click the warning in the console pane. The file that
contains the source of the warning will be found and opened, and you will be taken to the exact line of
code that generated the warning.

& C/C++ - app_skeleton_cpp/programming_models/traditional/startup_stm32f10x_hd.c - Eclipse E|[E|FZ|
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Even more information is available to you... notice the icon next to the line of code that generated the
warning. This icon also appears on the file icon in the Project Explorer tree. In the right-hand panel is
an outline of the code in this ¢ module. The function that generated the warning also has the warning
icon. If your compilation did not generate this warning, add something to the code that will generate
an error during compilation (for instance, delete a semi-colon), then build the project. The build will
hault once the error is detected, and you should be able to trace that error in the same ways that are
described above for the warning.

Create Your Own Projects
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Setup Eclipse to Debug MIOS32 Applications

This section documents how to setup and execute debug sessions using a JTAG interface to a midibox
STM32 core module.

The following is used in this section:

core:................ STM32

OS:........cceeees windows 7 x64 WinXP should work the same use with OpenOCD 0.5.0 (non x64)
toolchain:......mios32_toolchain (mentioned in the wiki). Ensure that workspace environment PATH
includes e.g C:\mios32_toolchain\bin

IDE:................. Eclipse (Indigo) later versions will probably not work at this point

OpenOCD.:....... 0.5.0 x64 Download

GDB:................. Yagarto (gdb version 7.3.1)later versions should workdownload

JTAG:................ Amontec JTAGkey-tiny many other brands and types of JTAG interface are supported
by OpenOCD

OpenOCD

Install OpenOCD

1. Unpack the OpenOCD download to C:\OpenOCD.

External Tools Configuration

Open Eclipse:External Tools Configurations.

figake  Search Run  Projeck

s-0-Q-|®=e

1. Click pulldown on button pictured above
. Select “External Tools Configurations...”
3. Click b_utton_ (new configuration, pictured highlighted)

& External Tools Configurations

Create, manage, and run configurations

N

Run a program

ype filker text]

=143, Proaram
4. Name: put “OpenOCD 0.5 (x64)” (or similar)
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5. Location: put “C:\OpenOCD\openocd-x64-0.5.0\bin\openocd-x64-0.5.0.exe”

6. Working Directory: put path to root directory of projects that may use this debug setup e.g
MW:\SWH

7. Arguments: “-f C:\OpenOCD\openocd-x64-0.5.0\interface\jtagkey.cfg -f C:\OpenOCD\openocd-
x64-0.5.0\target\STM32F1x.cfg"” the first argument is the JTAG interface config file, the second
is for the core chip.

GDB Debugger

Install Eclipse GDB Plugin

Open “Install” dialog: Help—Install New Software...

Work with: pulldown and select “Indigo - ht tp:/download.eclipse.org/releases/indigo”
In the tree shown, open branch at “Mobile and Device Development”

Click the box beside “C/C++ GDB Hardware Debugging”

Click “Next” at bottom of dialog

Follow the prompts to install the plugin

oUvhswWwNE

Install GDB

1. Download yagarto: Here
2. Unpack yagarto to C:\yagarto

Debug Configuration

This config will have the function of simply running the debugger with a project that is already flashed
in the midibox core (it may have been flashed using MIOS Studio in the usual way). It does not
actually build the program or flash it. Frequently you'll want to run the debugger for various test
cases without changing the program. This does it quickest.

¢ Open Debug configurations (click pulldown on button pictured below)

ntSVN/app.cpp - Eclipse

e Refactor Mavigate Search Run

|=|| a1d JEHG'%'J

¢ Select “Debug Configurations...”

e Name: type “YourProjectName debug” appropriately.

To the left of the “Apply” button is a link: “Select other..” click it.

Make sure “Standard GDB Hardware Debugging Launcher” is selected. Click “Ok”.

Beside the link it should say “Using Standard Hardware Debugging Launcher”

Main tab:»

C/C++ Application: e.g. “W:\sw\aMyProj\project_build\project.elf” (i.e full path to project *.elf
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file)
* Project: click browse button and select from list of workspace project names
¢ Select “Disable auto build” on this tab, to suppress the Make operation.
e Debugger tab:»
e GDB Command: “C:\yagarto\bin\arm-none-eabi-gdb.exe” (i.e full path to gdb executable)
e Command Set: select “Standard(Windows)”.
Protocol Version: select “mi”.
Check “Verbose console mode”.
Uncheck “Use remote target”
Startup tab:»
“Reset and Delay” is checked, “Halt” is checked
Text box in the “Initialization Commands” section:

target extended-remote localhost:3333
b main

monitor soft reset halt

monitor sleep 500

continue

clear main

“Load Image” unchecked

“Load symbols” checked

“Use project binary” selected. Should show path to project.elf
Source and Common tabs are not altered.

e Click “Apply” to save the configuration.

Running the Debug Configuration

In this procedure we will debug by building the application and flashing it into the core using MIOS
Studio, do this first then...

e Make sure OpenOCD process is running:

figate  Search Rum  Projeck

s-0-Q-®e

e Click pulldown on button pictured above and click on “OpenOCD 0.5 (x64)” item.
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I g
- _ ~

ECunsuIeEﬂ: |._.'|| Eﬁ|§||@|fa*fﬁ'

QpenOCD 0,5 (x64) [Program] C:\OpenOCD\openocd-x64-0. 5.0 bin\openocd-x64-0, 5.0.exe

Open On-Chip Debugger ©.5.8 (2811-85-89-23:28) ;I

Licensed under GNU GPL w2

For bug reports, read

m http://openocd.berlios.de/doc/doxygen/bugs. html

Info : only one transport option; autoselect 'jtag'
1888 kHz

adapter_nsrst_delay: 1lea

jtag_ntrst_delay: lea

cortex_m3 reset_config sysresetreq

Info : clock speed 1888 kHz

Info : JITAG tap: stm32.cpu tap/device found: @x3ba@d477 (mfg: @x23b, part: @xbadd, ver: 8x3)
Info : JITAG tap: stm32.bs tap/device found: 8x@6414841 (mfg: @828, part: @x6414, ver: @x@)
Info : stm32.cpu: hardware has 6 breakpoints, 4 watchpoints

e Open Debug configurations (click pulldown on button pictured below)

ntSVN/app.cpp - Eclipse

e Refactor Mavigate Search Run

O o | #5/-]0 - Q- |

Select “MyProject debug”

Cursor will stop at main() shown below. There will be all sorts of esoteric messages in the
console relating to the workings of GDB.

Run menu has all sorts of commands Resume,Suspend,Step Into,etc, etc.

Experiment by placing a breakpoint in a routine that you know should execute: right
click=Toggle Breakpoint.

e Resume execution, until cursor stops at the line of code where the breakpoint is: The Variables
frame shows the values of local variables.

Flash/Debug Configuration

In this configuration the app will be built, then flashed into the core, then loaded ready to execute.

¢ Open Debug configurations (click pulldown on button pictured below)

ntSVN/app.cpp - Eclipse

& Refactor Mavigate Search Run

| @ |30 -a- ]

e Select “Debug Configurations...”

e Copy the previous debug only configuration from the last section:
e (re)Name it “MyProject flash,debug”
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e Main tab—select “Enable auto build”
e Debugger tab— same as before.
e Startup tab— same except for contents of Initialization Commands text box:

target extended-remote localhost:3333
monitor reset halt

monitor wait halt

monitor poll

as well as in the “Run Commands” text box:

monitor flash probe 0

monitor stm32flx mass erase 0

monitor flash write image MyProjectFolder/project build/project.bin
0x08000000 bin

disconnect

target remote localhost:3333

monitor soft reset halt

e Click apply to save configuration settings

Running the Flash/Debug Configuration

The FreeRTOS StateViewer Plugin
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